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Introduction 

The new Pan London suspected cancer forms are designed to make it as easy as possible to 

refer patients with the minimum of effort. 

The forms are provided as EMIS Web Document Templates (files with the extension .ewdt).  

They contain special codes which interface with EMIS Web.  

Opening a template as a document within a patient’s EMIS Web medical record will 

generate a referral form, pre-populated with patient and practice details. GPs respond to 

questions in the clinical section of the form, typically by checking boxes or entering a 

minimum amount of text. 

The new forms will also automatically include relevant laboratory or imaging results stored 

in patients’ medical records. 

Before the templates can be used to generate referral forms, they must be installed into 

EMIS Web as EMIS web document templates. You cannot open them directly into 

Microsoft Word. 

This booklet explains how to correctly install the EMIS Web document templates so they can 

be used to generate suspected cancer referral forms. 

It also explains how to produce forms during consultations with patients and how 

completed forms can be sent to hospital trusts. 

Downloading the document templates 

In order to install the templates into EMIS Web, you will need to download a compressed 

(ZIP) file containing the form templates onto one of the computers in your surgery. 

The ZIP file is available from the Pan London Suspected Cancer Forms download site here. 

You can place this file anywhere on your computer. Once it has been used to install the 

templates onto your EMIS Web system, it can be safely deleted. It is simplest to download it 

straight onto your Windows desktop (see picture, below). 

 

  

https://www.myhealth.london.nhs.uk/nhsrefer/download/EMISWeb.html
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Double-click on the ZIP file 
In order to open it  
(see picture,  right).  

 

 

 

Select the folder named Pan London Forms, right-click on the folder and select menu item 

Copy. 

Next, right-click on your Windows desktop and choose menu item Paste. 

The folder should be visible on your windows desktop (see picture, below) and you can now 

safely delete the ZIP file. 

 

Double-click the folder icon to reveal its contents (see picture, below). 
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There are currently 13 different document templates that are used for suspected cancer 

referrals to various specialties. 

Although these templates generate Microsoft Word documents when opened up from 

within EMIS Web, they have to be installed into EMIS Web first. 

 

IMPORTANT NOTE 

These document templates cannot be opened in Microsoft Word directly. 

If you attempt to open a template by clicking on it from your Windows desktop you might 

receive an error message informing you that Windows cannot open the file. 

If you then attempt to proceed and open the file using Microsoft Word you will see the 

following window. 

 

If you see this window, please close it and follow the instructions below. 

The next section explains how to correctly install the templates so they can be used to 

generate referral forms. 
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Installing the forms 

Make sure you have the correct EMIS Web permissions to do this. 

You will have been assigned an EMIS Web Role Based Access Control (RBAC) number.  

This allocates the roles you are allowed when using EMIS Web. You must have the correct 

RBAC number to be able to install document templates. 

For example, a GP who wished to do this must be assigned Higher Level GP Status. You can 

see what status you have been assigned by looking at the bottom left hand corner of your 

EMIS Web screen (see picture, below). 

 

Without the correct RBAC number, the menu options required to install the templates will 

not be available to you.  

You will need to consult your practice manager or data controller if you find you are not 

presented with the menu options described below. 

You also should have downloaded the ZIP file containing the EMIS Web Document 

Templates onto your computer (see Downloading the document templates, above).  

The following discussion assumes you have downloaded the ZIP file and have successfully 

copied the folder it contains onto your Windows desktop. 

You only need to do this on one computer in your surgery. Once the document templates 

have been installed into EMIS Web, they will be available to all users on your network. 

 

Next, follow these steps… 

 

1. Place your mouse cursor over the EMIS Ball menu, located in the top left-hand corner of 

your EMIS Web screen 
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2. Click on the EMIS Ball menu to display the drop-down menu. Place your mouse cursor 

over the Configuration menu item  

but do not click the mouse yet. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. The Configuration menu option will  

automatically expand after a second or so 

(see picture, right). 
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4. Place the mouse cursor over the  

Template Manager menu item. 

 

 

 

 

 

 

 

 

 

 

 

5. Now click on the Template Manager menu item with the left mouse button. You will be 

presented with a screen similar to that shown below: 
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6. Observe the panel which occupies the left hand side of the screen (see picture, below). 

 

 

 

 

 

 

 

The panel contains two tabs: Templates & Protocols and Document Templates.   

Sometimes the name of the first panel can vary, so the Templates & Protocols tab might be 

replaced by one which says Library Items. This doesn’t matter because we are only 

interested in the Document Templates tab. 

Click on the tab labelled Document Templates (see picture, above: the Document Template 

tab is indicated by the red arrow). 

7.  You should see a list of the EMIS Web document 

folders used to store letters (see picture, right).  
 
Notice the top-most level of the list is the surgery name.  
It is highlighted in blue which means none of the folders  
below it have been selected. 
 
Also note the small arrows to the left of some of the  
folders. They indicate there are sub-folders contained  
within these folders.  
 
If you left-click with your mouse on a small arrow,  
the folder next to it will expand to reveal its subfolders. 
 
However, it won’t display any document templates  
which may also be contained in the folder. These are  
displayed in a separate panel to the right of this screen. 
This is discussed in more detail below. 
 
 
 



10 
 

8. When you select a folder using the mouse, any document templates or sub-folders 

contained in that folder are shown in the large panel to the right.  

In the picture below, the folder labelled Pan London Forms, which itself is a sub-folder of a 

folder labelled Referral Forms, contains the Pan London Suspected Cancer document 

templates. These are shown listed in the panel to the right of the folder list.  

 

The following discussion explains how to import the files from the folder you downloaded 

from the Pan London Suspected Cancer referral forms website into EMIS Web. 

9. In order to import the form document templates into EMIS Web as shown above, you 

first need to select one of the EMIS Web document template folders on your system. This 

folder will be used to contain the form document templates.  

If you don’t select an EMIS Web document template folder, you are not given the option to 

import files.  

  

Document templates within 

the selected folder 
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In the example below, the button on the menu ribbon towards the top of the screen 

labelled Import is disabled and cannot be selected. This is because an EMIS Web document 

template folder has not been selected—the surgery name rather than a folder is selected. 

 

 

 

 

 

 

 

 

 

10. When you select an EMIS Web document template folder, the button labelled Import is 

enabled. 
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11. You can now click on the Import button. 

 

12. You are given the choice of importing either an entire folder or just a single document 

template (.ewdt file).  

If you import a single document template, the template is placed within the EMIS Web 

document template folder you originally selected. 

If you import an entire folder, it becomes a sub-folder within the EMIS web document 

template folder you originally selected. This sub-folder will contain all the files you have 

downloaded. 

13. You will now be able to select the file or folder you wish to import. This must be located 

somewhere on your computer. If you have been following the instructions in this document, 

you will find the files located in a folder on your Windows desktop named Pan London 

Forms. 

 

14. Select the file or folder you wish to import and click on the button marked Open. 
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15. The document template or folder will appear on your EMIS Web system, stored within 

the EMIS Web document template folder you originally selected. 

You have successfully imported your document template. 

Altering a form 

The Pan London forms are semi-protected, which means you can use form elements such as 

check boxes but still alter most of the text in the document without disabling form 

protection. 

You will need to alter the form document template because EMIS Web does not have the 

ability to add your surgery’s bypass telephone number (your surgery’s private number, 

which is not for general release). 

Of course, you can do this once you have generated a referral form. However GPs would 

have to do this each time they made a referral. 

 

If you open up the form document 

template from the Template 

Manager screen you can enter the 

surgery bypass number into the 

document and save it.  

This will then display each time the 

document template is used to 

generate a referral form. 

See picture right, which shows how to 

bring up the Template Manager 

screen. 
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Open the required form document template from the Template Manager screen by right-

clicking on it with the mouse and choosing menu item Document Template and then menu 

item Edit from the pop-up menu. 

 

Details such as surgery bypass telephone numbers can be edited without disabling form 

protection. 

When a form has been generated, you can alter most of the patient and practice details 

without disabling form protection. 

However, the clinical details section is protected. 

In the following section you will be shown how to disable form protection so you can make 

the form fully editable. However, you should note that you will have to re-enable form 

protection once you have done this, otherwise check boxes and text boxes will not work. 

How to disable form protection 

1. You must have the Developer tab activated on your Microsoft Word Ribbon menu.  

2. You cannot activate the Developer tab from a Microsoft Word document within EMIS 

web. You need to run Microsoft Word as a separate application from your Windows Start 

menu. 
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3. Right-click with the mouse anywhere on a blank area of the Microsoft Word Ribbon menu below 

any large buttons and select the menu option Customize the Ribbon. 

 

You will be presented with the window shown below. 

 

4. The box to the right of this screen allows you 

to customise the ribbon. Highlight the Developer option. Enable the 

Developer tab by clicking on the small check box with the mouse. 
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5. Next, close this window by clicking on the button labelled OK, located at the bottom-right 

of the window. 

 

 

6. The Developer tab has now been enabled in Microsoft Word on your computer (see 

picture, below) 

 

 

7. Click on the Developer tab (ringed in the picture above) to display the Developer ribbon 

menu (see picture, below) 

 

8. Having activated the Developer ribbon menu, it will be available within document 

templates being edited from within Microsoft Word running under the control of EMIS Web. 
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9. You are now ready to disable protection for an EMIS Web document template.  

First, you must open up the document you wish to alter from the Template Manager screen 

in EMIS Web. Choose to edit the relevant document template (see picture, below). 

 

10. Once the template has been opened, click on the Developer tab to display the Developer ribbon 

menu. 
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Click the Restrict Editing button. A panel is displayed to the right of your document. 

 

Notice the button at the bottom of this panel 

labelled Stop Protection. Click this button to turn 

protection off.  

 

 

 

 

 

 

 

 

When you do this, the panel alters, giving you the option to 

re-enable protection when you need to. You can now make 

as many changes as you wish to the document. When you 

have finished, you will need to re enable protection. 

11. Restoring protection is the reverse of the process 

described above.  

Note the item labelled Editing restrictions in the panel (see 

picture, left). 

It is important that the check-box below it labelled Allow only 

this type of editing in the document is checked and that 

Filling in forms is shown in the box below it. 

Click on the button in the panel to the right of your document 

labelled Yes, Start Enforcing Protection. 
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This will display a dialog box asking you if you would like to add a password (see picture, 

below). 

 

You will not be using a password, so keep the password boxes empty and just click on the 

button labelled OK. 

Your document is now protected and check boxes on the form will respond to mouse clicks 

as expected. 

 

How to produce a referral form for your patient 

1. When you wish to use one of the forms to refer a patient, you need to create a new 

document within your patient’s medical record from the Documents screen in EMIS Web. 

Click on the Add button on the far left of the EMIS ribbon menu.  

                                    Choose menu item Create Letter from the drop-down menu. 
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2. A dialog box appears which contains a list of the most recently opened documents.  

Click on the search button. 

 

 

3. You are presented with a new screen. This has an EMIS Web folder list displayed on its 

right hand side, enabling you to select the form you wish to use (see picture, below).  

Alternatively, type the name of the form into the search box in the top left hand corner of 

the screen and click the search button. 
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4. When you have found the form you wish to use, select it and click on the button labelled 

OK to open it. You are then presented with your form. 

5. The patient and practice details will have been pre-filled, including such items as the 

referral date, the name of the referring doctor and routine clinical details such as the 

results of any required investigations, current repeat medication, allergies and major 

medical problems. 

6. You should always review the routine clinical details before sending the form off.  

Delete any irrelevant details and make sure that everything required for the referral has 

been placed on the form. 

Sending your form: fax or email? 

It is NHS policy that all forms will be sent via email or by e-referral instead of fax by April 

2016. 

Each Pan London suspected cancer form has a web link to an on-line directory on the first 

page of the form. The directory lists the hospitals/trusts together are available to take your 

referral. Full contact details are provided.  

Contact details can be copied onto the form using standard Microsoft Windows copying and 

pasting and can also be pasted into Microsoft Outlook in order to email the form. 

 

SECURITY NOTE:  
1. Only send forms from a secure (nhs.net) email address.  
2. Only send forms to a secure (nhs.net) email address.  
 

Emailing your referral form 

EMIS Web has the facility to allow you to send forms or any other document by email.  

You must have Microsoft Outlook installed on your computer. Ideally your surgery should 

have a referrals email account. This is a general account not specifically attached to one 

individual.  

You will need to know the email address of your referrals account and its password. 

These details need to be added as an account to each copy of Microsoft Outlook on every 

computer in your surgery. 

If EMIS Web and Microsoft Outlook have been set up correctly emailing forms is very 

simple, though there are some bugs in EMIS Web you need to be aware of. 
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Setting-up Microsoft Outlook 

In order to do this you must have Microsoft Outlook 

installed on your computer.  

If it has been installed you will be able to find it by 

clicking on the All Programs menu item from the 

Windows Start menu. 

 

 

 

 

 

 

 

You will be presented with a list of all the programs 

installed on your computer. 

Microsoft Outlook is part of the Microsoft Office 2010 

suite of programs and can found by clicking on the folder 

marked Microsoft Office (see picture, right). 

Click on this in order to run Microsoft Outlook. 

If this is the first time Microsoft Outlook  

has been used, it will open a software  

“wizard” which will ask you if you wish  

to add an email account. 

You must have the following details to hand 

1. The email address you will be sending referrals 

from. 

2. The password for this email account. 

Input the details when requested and your email account 

will be ready for you to use. 
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If the wizard does not run, you can add an account manually very easily.  

Click on the File menu option.  

 

 

 

 

 

 

 

 

Click on the button marked Add Account and you will be taken to a screen that allows you 

to enter your email account's details. 

You will be presented with the following window (see picture, below) 

 

You will need to enter your account details in the relevant sections. Note that the email 

address of the account you are setting up is entered on the second line. The first line is for a 

descriptive name. You need to enter the account’s password twice. 
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Click on the button marked Next. 

Outlook will take a few seconds to set your account up 

 

Eventually you should see the following screen indicating your email account has been 

successfully created in Microsoft Outlook. 
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You are now ready to send emails with file attachments from your computer.  

EMIS Web should be able to open up Microsoft Outlook and attach a document previously 

saved in a patient’s medical record to a blank email. This can be sent to the relevant hospital 

trust. 
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Sending an email attachment using EMIS Web 

In principle, this can be done when you save any document you have created.  

Before you do so, however, you should copy the email address of the hospital trust you are 

sending the referral to. 

The list of hospitals you are able to refer the patient to is accessed via a web link on the 

form. 

Hold the control key down while you click on the link (see picture, below). 

 

The list will be opened in your browser. What you see depends on the capability of your 

browser.  

1. If you are using Internet Explorer version 8 or earlier (or older versions of FireFox or 

Opera) you will see the following screen (see picture, below) 
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Using the mouse, select the hospital you wish to refer the patient two by clicking to the left 

of the hospital name, holding the left mouse button down and dragging the mouse the right 

to select the entire line (see picture, below) 

 

Having selected the entire line, right-click with your mouse and choose menu option  
Copy from the pop-up menu (see picture, below). 

 

 

 

 

 

 

You can now close your browser down and return to the form. 

2. If you are using Chrome or Internet Explorer versions 9 or later (or updated versions of 

FireFox or Opera) you will see the following screen (see picture, below). 
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Select the hospital you wish to refer the 

patient to from the list on the left hand side of 

the screen (see picture, left). 

 

 

 

If you can’t find the hospital easily in the list, use the search box to help you find it more 

quickly (see picture, below). 

 

 

The contact details of the hospital you 

have selected appear in the box on the 

right-hand side of the screen (see 

picture, right). 

Click the button labelled Copy selected 

hospital to Windows clipboard. This will 

copy the hospital name plus the email 

address only (see picture, below). 
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Having copied the required details and depending on the capability of your browser, you 

may be offered the option to close the current tab. 

 

If you select Yes, and there are no other tabs open in your browser, the browser will close 

and you will return to your referral form. If there are other tabs open, you will need to 

return to your referral form manually. 

The referral form has a line into which you can paste the copied hospital details. 

Right-click on the form in this area (see picture, below)... 

 

...and select the first choice from menu option Paste Options: from the popup menu (see 

picture, below) 
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You can achieve the same result by pressing the keyboard combination Ctrl + V. 

The hospital you selected, plus associated contact details, will now appear in the box on the 

form (see picture, below). 

 

The hospital name and email address will remain on your Windows clipboard (provided you 

don't copy anything else in the meantime), ready for you to paste it into the To line of your 

email client. In EMIS Web systems this will typically be Microsoft Outlook. 

Next, you will instruct EMIS Web to save the document and open Microsoft Outlook with 

the document as an attachment, which can then be emailed. 

You will be familiar with saving documents if you have used EMIS Web for a while.  

Clicking on the File button, which is situated to the left of the document being edited, gives 

you five different options. 

In this case you will be choosing option Save As (see picture, below). 
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You will be presented with 

the dialog box shown in the 

picture (right). 

Check the box labelled Send 

email. 

 

 

When this is checked, clicking on the button marked OK should save the file, open Microsoft 

Outlook and then open up a blank email with the document attached (see picture, below) 

 

When Microsoft Outlook opens, place the mouse cursor in the box labelled To… then right-

click with the mouse. 

 

Select Paste from the menu. 
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The email address you copied from the form will then be pasted into Outlook. 

Press the Send button to email the file to the hospital trust. 
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You can also email a file you have already created and saved from the Documents screen in 

the patient’s medical record. 

 

 

 

Select the document using the mouse. 

Right-click on it and choose menu item, View Document. 
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The EMIS Web Document Viewer window will open, displaying your document, as shown in 

the picture below. 

Once it has opened, select and copy the email address you wish to use from the document. 

 

Clicking on the button labelled Send enables you to choose to send the document via email. 

 

Select the menu item via Email and Microsoft Outlook will open up ready for you to send 

the attached document.  
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Right-click anywhere in the box labelled To… and select menu item Paste.  

 

 

 

 

 

 

 

 

 

The hospital trust email address you copied will appear in this box. 

 

Click the button labelled Send to send the email to the hospital trust. 

 


